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Quick Start Tutorial 

 

RocTopple is an interactive and simple to use analysis tool for evaluating 
block toppling in rock slopes. This “quick start” tutorial will introduce you 
to the basic features of RocTopple, and demonstrate how easily a model 
can be created and analyzed with the software. 

The finished product of this tutorial can be found in the Tutorial 01 
Quick Start.rtop file. Tutorial files installed with RocTopple 1.0 can be 
accessed by selecting File > Recent Folders > Tutorials Folder from the 
RocTopple main menu. 

Topics Covered in this Tutorial 

• Project Settings 
• Deterministic Analysis 
• Input Data 
• 3D View 
• Viewing Options 
• Analysis Results 
• Info Viewer 
• Water Pressure 
• External Force 
• Seismic Force 
• Sensitivity Analysis 
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Introduction 

RocTopple computes the factor of safety for block toppling using 
geometry generated from the Goodman and Bray method (1976). The 
slope is defined by: 

• The slope face (A) 

• The upper slope face (B) 

• The overall base inclination (C) 

• The toppling joints (D) 

Typical problem geometry is illustrated below. 

 

Figure 1: Classic Goodman and Bray geometry for RocTopple analysis. 

The method assumes uniform spacing of the toppling joints, and 
that the basal failure plane for the blocks is perpendicular to the 
dip of the toppling joints. 

The heights of the blocks are generated such that they follow the 
slope and upper slope angle. The blocks intersect the slope plane 
(A) and upper slope plane (B) at the midpoints of the top of the 
blocks.  This method results in the area of the blocks being equal 
to the area of the triangle formed by the slope (A), the upper slope 
(B) and the overall base plane (C). 
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Creating a New File 

If you have not already done so, run the RocTopple program by double-
clicking on the RocTopple icon in your installation folder. Or from the 
Start menu, select Programs → Rocscience → RocTopple 1.0 → 
RocTopple. 

If the RocTopple application window is not already maximized, maximize 
it now, so that the full screen is available for viewing the model. 

When the program is started, a default model is automatically created, 
allowing you to begin defining your model immediately. If you do NOT 
see a model on your screen: 

Select: File → New 

Whenever a new file is created, the default input data will form valid 
slope geometry, as shown in Figure 2. 

 

Figure 2:  Default model. 

Notice the split screen format of the display. The 2-D view shows the 
slope geometry and the factor of safety, while the 3-D view is interactive. 
Note that the computation is for 2-D geometry and assumes unit depth. 

 



 Quick Start Tutorial 1-4  

RocTopple v.1.0 Tutorial Manual 

Project Settings 

The Project Settings option allows you to configure the main analysis 
parameters for your model (i.e. Analysis Type, Units etc). Select Project 
Settings from the toolbar or the Analysis menu.  

Select: Analysis → Project Settings 

You will see the Project Settings dialog. 

 

Figure 3:  Project Settings dialog. 

Analysis Type 
There are two main Analysis Types in RocTopple – Deterministic or 
Probabilistic. By default, a Deterministic Analysis will be selected for a 
new file. 

• A Deterministic analysis assumes that all input parameters are 
“exactly” known. RocTopple computes the factor of safety for a 
single set of input data. Deterministic analysis will be 
demonstrated in this tutorial. 

• For a Probabilistic analysis, statistical input data can be 
entered to account for uncertainty in geometry and joint strength 
values. Statistics can also be applied to external loads. This 
results in a safety factor distribution, from which a probability of 
failure is calculated.  
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Units 
For this tutorial we will be using the Metric units, stress as kPa.  
Select this option from the Units combo box.   

NOTE: the most recently selected Units option automatically becomes the 
default for all new files, so you do not have to re-select the Units each 
time you start a project. 

Sampling and Random Numbers 
In RocTopple, all probabilistic analysis is done using pseudo-random 
sampling. This means all samples are generated using the same seed, and 
results can be reproduced. 

Project Summary 
Select the Project Summary tab in the Project Settings dialog. 

Enter “RocTopple Quick Start Tutorial” as the Project Title.  

 

NOTE: 

• The Project Summary information can be displayed on printouts of 
analysis results, using the Page Setup option in the File menu and 
defining a Header and/or Footer. 

• You can specify the Author and Company in the dialog so that this 
information always appears by default in the Project Summary for 
new files.  

Select OK to close the Project Settings dialog.  If you have changed the 
unit system, you will be warned that program specific defaults will be 
changed when you exit the Project Settings dialog. 
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Input Data 

The Input Data option is the main input data dialog for RocTopple. It 
allows users to input slope geometry and rock strength parameters. Let’s 
see what input data is used for the default RocTopple model.  

Select: Analysis → Input Data 

 

Figure 4:  Input Data dialog (Deterministic) – slope geometry properties. 

For a Deterministic analysis, the Input Data dialog is organized under 
two tabs  – Geometry and Strength. 

Examine the Geometry properties. All values are mandatory for input. 
Do not change any values just yet, we will be coming back to this shortly. 

Select the Strength tab in the Input Data dialog.  In this tab you define 
both the strength of the base joints (bottom of the blocks) and the 
strength of the toppling joints (between the blocks). There are two 
strength models available for defining the shear strength of joints – 
Mohr-Coulomb and Barton-Bandis. By default, the Mohr-Coulomb 
strength model is selected. 

TIP: keeping “Instant Preview” checked will allow you to view changes in 
your model as you are changing the parameters in the input data dialog. 
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Figure 5:  Input Data dialog (Deterministic) – rock properties. 

External forces are applied through other dialogs. Users have the option  
to apply Water Pressure, Seismic Loads, Line Loads, Distributed Loads 
and Bolts. We will be demonstrating these options later in the tutorial. 

NOTE: for detailed information about all RocTopple input data options, 
see the RocTopple help system. To access the Help system, you can select 
the question mark “?” icon in a dialog for context sensitive help. Or you 
can select Help > Help Topics from the menu. 

Select Cancel to close the Input Data dialog. 
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Analysis Results 

The RocTopple analysis is automatically computed when: 

• A file is opened, or 

• Input data is entered or modified in a dialog (e.g. Input Data), 
and Apply or OK is selected in the dialog. 

This ensures that the latest analysis results are always displayed. 

The primary results from a RocTopple Deterministic analysis is displayed 
in the 2-D View legend. 

 

 

Info Viewer 

A comprehensive listing of input data and analysis results is presented in 
the RocTopple Info Viewer. To access the Info Viewer, select the Info 
Viewer option from the toolbar or the Analysis menu.  

Select: Analysis → Info Viewer 

 

Figure 6:  Info Viewer summary of analysis information. 
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Use the scroll bar or the mouse wheel to scroll down and view all of the 
data in the Info Viewer. 

The Info Viewer data can be copied to the clipboard or saved to a file 
using the options in the right-click popup menu. This is left as an optional 
exercise. 

Close the Info Viewer by selecting the X in the upper right corner of the 
view. 
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3-D View 

The 3-D View in RocTopple is interactive and shows the critical failure 
mode of blocks at the point of failure.  

By default, the 3-D view is isometric.  

 

Moving Blocks 
Double-click on the 3-D view to maximize it.  

To see how each block would fail, first hover the mouse over the slope. 
Notice that the cursor changes to a “two-way arrow”  . Left-click and 
drag the mouse down to see the blocks move. 

 

Figure 7:  Displacement of blocks with left-click and drag of mouse 
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To reset the blocks to their original positions, either left-click and then 
drag the mouse up, or click “Reset Slope” in the right-click menu.  

The blocks can also be moved by scrolling the mouse wheel. 

View Options 
The slope can be viewed from multiple perspectives. To rotate the slope, 
first left-click on the background (white space), and then drag the mouse. 
Notice the cursor changes to .  

For viewing the 3-D slope in other orientations: 

Right click  Display Orientations 

   

Figure 8:  Examples of slope display orientations (front, right, top) 

 

Re-sizing the Views 

You can change the relative size of the 2-D or 3-D view. To maximize the 
size of any pane, double-click the left mouse button in the pane (e.g. 
double-click in the 2-D view to maximize the 2-Dview). Double-clicking 
again in the maximized view will restore the default display of 2 panes. 

• You can also re-size the 2-view display by clicking and dragging 
on the vertical divider between the panes. 

TIP: if you have re-sized the panes and you want to quickly restore the 
default display, double-click in any pane to maximize the view, and then 
double-click again to restore the default display. 
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Zoom and Pan 
The following Zoom and Pan options are available for both the 2-D view 
and 3-D view:  

• Zoom Extents – resets the model to its default size and location 
in the view 

• Zoom In – zooms in to 90 % of the original area 

• Zoom Out – zooms out to 111% of the original area 

• Pan – translates the model left, right, up or down within the view 

The zoom and pan options are available in the toolbar, the View menu, 
and through various keyboard and mouse shortcuts. Shortcuts include: 

• Rotate the mouse wheel forward or backward to zoom in or out in 
the 2-D view. 

• The function keys F2, F4 and F5 are shortcuts to Zoom Extents, 
Zoom Out and Zoom In, respectively. 

• A shortcut to Pan is to click and hold the mouse wheel and drag 
to pan the model within the view. 
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Changing Input Data 

Now let’s enter data for a different slope. 

Select: Analysis → Input Data 

Select the Geometry tab in the Input Data dialog and enter the 
following data. 

Slope Angle 70 

Slope Height 60 

Upper Slope Angle 0 

Toppling Joint Spacing 8 

Toppling Joint Dip 60 

Overall Base Inclination 45 

Rock Unit Weight 25 
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Select the Strength tab in the Input Data dialog and enter the following 
data for both the Base and Toppling Joints. 

Shear Strength Model Mohr-Coulomb 

Joint Friction Angle 30 

Joint Cohesion  20 
 

 

Notice that with “Instant Preview” checked, RocTopple automatically 
updates the results in the 2-D and 3-D views. The factor of safety now 
should be 0.8. 

Select OK to close the dialog. 

 

Figure 9:  Slope formed from new input data. 
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Results indicate that at a shear strength reduction factor of 0.8, 
blocks 1 and 2 are sliding critical, blocks 3 – 8 are toppling critical, 
and blocks 9 and 10 are stable. 

Water Pressure 
By default, Water Pressure is NOT applied to a RocTopple model, and the 
analysis is therefore applicable to a DRY slope. 

To include Water Pressure in a Deterministic analysis: 

Select: Water → Water Pressure Options  

In the dialog, select the Pore pressure in joints option. This allows you 
to specify a percent fill in the toppling joints. Enter 50%. 

 

Select OK. The factor of safety is now 0.715.  

Notice that blocks now have lighter colored areas to indicate the water 
level.  

The symbol at the top right of the 2-D view shows that the joints 
are 50% filled in length with water. For easy access to the water dialog, 
you may right-click on this symbol and then Modify Water Pressure. 
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Figure 10:  Model with water pressure. 

 

Bolt 
Now let’s add a single bolt that will add to the resisting force of the toe 
block. 

1. SupportAdd Bolt.  

2. Enter Capacity = 250, Height above Toe=35, Angle = 0, 
Length=32 and Spacing = 0.5m. 

 

The factor of safety (with Water Pressure still applied) increases to 0.75. 
Click Ok to close the water dialog. 

 The bolt may be edited, moved or deleted simply by right-clicking on it. 
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Seismic Force 
Now we will include Seismic Force in the analysis. 

1. LoadingSeismic Load.  

2. Enter a Horizontal Seismic Coefficient of 0.1.  

 

3. Select OK. The factor of safety drops to 0.665.  

 

Figure 12: Slope with water pressure, seismic loading and bolt. 

The symbol at the top right of the 2-D view indicates that a 
horizontal seismic coefficient of 0.1 and to the left is applied on the slope. 
For easy access to the seismic dialog, you may right-click on the symbol 
and then Modify Seismic Load. 

The Seismic Force (F) is applied to each block.  

F = 0.1 * g * m, where 0.1 = horizontal seismic coefficient, g = acceleration 
due to gravity, and m = mass of the block.  
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Sensitivity Analysis 

Before we conclude this tutorial, we will demonstrate the Sensitivity 
Analysis feature of RocTopple. 

In a Sensitivity Analysis, individual variables can be varied between user 
defined minimum and maximum values, while all other input parameters 
remain constant. This allows you to determine the effect of individual 
variables on the safety factor. 

We will use Sensitivity Analysis to prove that increasing the seismic 
loading in the left horizontal direction will decrease the factor of safety. 
Leave the water pressure and bolt attributes as they are. 

1. Select the Sensitivity Analysis option from the toolbar or the 
Analysis menu.  

2. In the Sensitivity Analysis dialog, click “Add” to add a sensitivity 
variable.  

3. Under the “Variable” column, select Horizontal Seismic 
Coefficient. Change the To value of the Range to plot a sensitivity 
graph from 0 to 0.1. Select Plot. 

 

 

4. You should see the following sensitivity plot. 
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Figure 13:  Sensitivity plot of seismic force versus safety factor. 

You can clearly see from the graph that the factor of safety decreases 
with increase in the horizontal seismic coefficient.  

By default, RocTopple calculates the factor of safety for 50 samples in the 
sensitivity analysis.  

We conclude this quick start tutorial. 
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